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Copyright © Ramona Optics, Inc. 2018-2022 
Durham, North Carolina, USA 
 
The information contained in this document is subject to change without notice. 
 
Disclaimer 
The Ramona Optics MCAMTM is a Gigapixel MicroscopeTM that is provided as a beta-unit for use by the 
user “AS-IS” and any express or implied warranties, including but not limited to, the implied 
warranties of merchantability and fitness for a particular purpose are disclaimed. 
 
Licensing 
A copy of the license agreement is included along with the software package. If you have not received 
this agreement please contact Ramona Optics. 
 
All third party licenses can be found within the MCAM™ GUI by selecting “About” in the “Help” menu. 
 
Trademarks 
Ramona Optics® is a registered trademark of Ramona Optics, Inc.  
All other trademarks are the sole property of their respective owners. 
 
"Python®" and the Python® logos are trademarks or registered trademarks of the Python Software 
Foundation, used by Ramona Optics with permission from the Foundation. 
 
Contact 
 
Ramona Optics 
1000 West Main Street, Suite #2A 
Durham, NC 27701 
 
Phone: (919) 590-5851 
Email: info@ramonaoptics.com 
Website: https://www.ramonaoptics.com/ 
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Technical Specifications 
System Ratings 
Mains Supply: 100-240 VAC, 50/60Hz, 10A 
Indoor use only 
Altitudes up to 2000m 
Temperatures 15-28C 
Maximum relative humidity: 80% up to 31C, decreasing linearly to 50% at 40C 
OVERVOLTAGE CATEGORY II (EN 61010-1 2010) 
POLLUTION DEGREE II (EN 61010-1 2010) 
 
System Specifications 
MCAM™ Dimensions: 483 x 661 x 534mm (width x height x depth) 
Mass (weight): 41kg (90lbs) 
Electrical outlets: Up to three (3) outlets for the MCAM, Computer, and Monitor Display. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Ramona Optics - MCAMTM User Guide for Automated Workflows 

​ ​ ​ ​ ​ ​ ​ ​ ​ ​ ​ ​  
​ 3 



Safety Warnings and Precautions 
The MCAM™ system should always be used in accordance with the guidelines of this manual to avoid risk of 
personal injury and/or damage to the instrument. If the MCAMTM system is used in a manner not consistent 
with the manner specified by Ramona Optics, Inc. in this manual, protection provided by the equipment 
may be impaired.  
 
Note the following safety warnings: 
 

 

The MCAM™ system is heavy (~90 lbs/41 kg). Use caution when lifting. Use your legs and core 
muscles to lift the equipment, not your back. Keep the load close to your body during the lift. 
Maintain a firm grip on the load with both hands. 

 

The MCAM™ system is heavy. For stability, position all system hardware on a stable surface prior 
to use.  

 

Prior to moving, cleaning, or performing maintenance on the MCAM™ system, always power off 
and disconnect power from hardware and disconnect MCAM™ and MCAM™ Workstation.  

 

The MCAM™ is an electronic system. Do not touch any MCAM™ system hardware with wet hands. 

 

Ventilation is required for proper function of the MCAM™ system. Make sure to leave a minimum 
of two inches or 5 cm of space around all sides of the MCAM™ as well as the MCAM™ Workstation. 

 

MCAM™ system's  X, Y, and Z stages can cause pinch hazards for users can move quickly. To avoid 
pinch hazard, ensure hands are outside MCAM™ imaging chamber before operating the moving  
MCAM stages using the provided software. 
 

 

LEDs on MCAM™ Reflection Illumination Module can become very hot after use. Do NOT touch 
any part of MCAM™ Reflection Illumination Module except for Quick Release Handles (see 
MCAM™ User Manual). 
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Avertissements de sécurité et précautions 
Le système MCAM™ doit toujours être utilisé conformément aux directives de ce manuel afin d'éviter tout risque 
de blessure personnelle et/ou de dommage à l'appareil. Si le système MCAM™ est utilisé d'une manière non 
conforme aux indications spécifiées par Ramona Optics, Inc. dans ce manuel, la protection offerte par 
l'équipement peut être compromise. 
 
Prenez note des avertissements de sécurité suivants : 
 

 

Le système MCAM™ est lourd (~90 livres / 41 kg). Faites attention lorsque vous le soulevez. 
Utilisez vos jambes et les muscles de votre tronc pour soulever l'équipement, pas votre dos. 
Gardez la charge près de votre corps pendant le soulèvement. Maintenez une prise ferme sur la 
charge avec vos deux mains. 

 

Le système MCAM™ est lourd. Pour une meilleure stabilité, placez tout le matériel du système sur 
une surface stable avant son utilisation. 

 

Avant de déplacer, nettoyer ou effectuer la maintenance du système MCAM™, éteignez toujours 
et débranchez l'alimentation du matériel et déconnectez le système MCAM™ et la station de 
travail MCAM™. 

 

Le MCAM™ est un système électronique. Ne touchez à aucun composant matériel du système 
MCAM™ avec vos mains mouillées. 

 

Une ventilation est nécessaire pour le bon fonctionnement du système MCAM™. Assurez-vous de 
laisser un espace minimal de  5 cm  autour de chaque côté du MCAM™ ainsi que de la station de 
travail MCAM™. 

 

Les plateaux X, Y et Z du système MCAM™ peuvent présenter des risques de pincement car ils 
peuvent se déplacer rapidement. Pour éviter ceci, assurez-vous que vos mains sont à l'extérieur 
de la chambre d'imagerie MCAM™ avant d'opérer les déplacements des plateaux MCAM à l'aide 
du logiciel fourni. 

 

Les LED du module d'éclairage par réflexion MCAM™ peuvent devenir très chaudes après 
l’utilisation de l’appareil . Ne touchez à AUCUNE partie du module d'éclairage par réflexion 
MCAM™ à l'exception des poignées de dégagement rapide (voir le manuel d'utilisation 
MCAM™). 
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Sicherheitswarnungen und Vorsichtsmaßnahmen 
Das MCAM™-System sollte immer gemäß den Richtlinien dieses Handbuchs verwendet werden, um 
das Risiko von persönlichen Verletzungen und/oder Schäden am Gerät zu vermeiden. Wird das 
MCAM™-System auf eine Art und Weise verwendet, die nicht mit den von Ramona Optics, Inc. in 
diesem Handbuch angegebenen Verfahren übereinstimmt, kann der durch die Ausrüstung 
gebotene Schutz beeinträchtigt werden. 
 
Beachten Sie die folgenden Sicherheitswarnungen: 
 

 

Das MCAM™-System ist schwer (Modell A: ~29 lbs/13 kg; Modell B: ~90 lbs/41 kg). Seien Sie 
vorsichtig beim Heben. Benutzen Sie Ihre Bein- und Rumpfmuskulatur zum Heben der 
Ausrüstung, nicht Ihren Rücken. Halten Sie die Last während des Hebens nah am Körper. 
Behalten Sie einen festen Griff an der Last mit beiden Händen. 

 

Das MCAM™-System ist schwer. Für die Stabilität positionieren Sie die gesamte Systemhardware 
vor der Verwendung auf einer stabilen Oberfläche. 

 

Bevor Sie das MCAM™-System bewegen, reinigen oder Wartungsarbeiten daran durchführen, 
schalten Sie immer zuerst aus und trennen Sie die Stromversorgung von der Hardware und 
trennen Sie das MCAM™ und die MCAM™-Workstation. 

 

Das MCAM™ ist ein elektronisches System. Berühren Sie keine Hardware des MCAM™-Systems 
mit nassen Händen. 

 

Eine Belüftung ist für die ordnungsgemäße Funktion des MCAM™-Systems erforderlich. Stellen 
Sie sicher, dass auf allen Seiten des MCAM™ sowie der MCAM™-Workstation mindestens zwei Zoll 
oder 5 cm Platz gelassen werden. 

 

Die X-, Y- und Z-Achsen des MCAM™-Systems können sich schnell bewegen und so 
Quetschgefahren für Benutzer verursachen. Um Quetschgefahren zu vermeiden, stellen Sie 
sicher, dass Ihre Hände außerhalb der Bildgebungskammer des MCAM™ sind, bevor Sie die 
beweglichen MCAM-Stufen mit der bereitgestellten Software betreiben. 

 

Die LEDs am MCAM™-Reflexionsbeleuchtungsmodul können nach Gebrauch sehr heiß werden. 
Berühren Sie KEINEN Teil des MCAM™-Reflexionsbeleuchtungsmoduls außer den 
Schnellverschlussgriffen (siehe MCAM™-Benutzerhandbuch). 
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Das MCAM™ ist ein elektronisches Gerät. Trennen Sie vor dem Bewegen, Reinigen oder 
Durchführen von Wartungsarbeiten den Strom. 
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Equipment Ratings 
The MCAM™ system is rated for use in the following conditions: 

●​ Indoor use 
●​ Altitude up to 2000m 
●​ Temperature 15C-28C 
●​ Maximum relative humidity 80% for temperatures up to 31C decreasing linearly to 50% relative humidity 

at 40C 
●​ MAINS supply voltage fluctuations up to +/-10% of the nominal voltage 
●​ Short duration overvoltages occurring on the MAINS supply 
●​ Only non-conductive pollution (solid, liquid, or gaseous foreign matter that may produce a reduction of 

dielectric strength or surface resistivity), except that occasionally a temporary conductivity caused by 
condensation is expected 
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MCAM™ Features 

 
 

Introduction 
The intended use of this MCAM™ system is to image 96, 384, 1536 well plates in an automated workcell 
for cell  morphology assessment, contamination detection, organoid debris accumulation, and media 

quality. In order to use the MCAM™ for imaging within the automated workcell, a protocol must be 
created within the MCAM GUI and saved in a specific file location that is compatible with 

GreenButtonGO. Sections 1-3 of this user guide outlines the features of the MCAM™ GUI necessary to 
optimize imaging parameters for creating a protocol. Section 4 summarizes how to edit the preloaded 
protocols, create new protocols, and integrate protocols with Green Button Go for automated image 
acquisition.  
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Unpacking the MCAMTM 

 

 

Removing Packing Material and Stage Lock Pin From Inside the MCAM 

 
The MCAM is shipped with protective foam and bubble wrap near the fluorescence illumination 
modules, as shown in Figure 2. This material needs to be removed before the system can be operated.   
​
Step 1: Remove the top Panel first, then the side panel. The top panel locks all panels in place, so after 
it is removed, any other panel can be removed for maintenance. 

 
 
 
 
 
 
 
 

 
Ramona Optics - MCAMTM User Guide for Automated Workflows 

​ ​ ​ ​ ​ ​ ​ ​ ​ ​ ​ ​  
​ 12 



Step 2: Remove Stage Pin from stage and place in hole at side of MCAM as shown 

 
​
Step 3: Remove Packing material from the system, save for repacking as it is anti-static packaging. 

 
Figure 2. Protective packing material which must be removed 
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Enabling the System Power Supply 
 
The MCAM is shipped with the system power switch disconnected from the system power supply.  After 
the MCAM is unpacked and the protective foam and bubble wrap have been removed from inside the 
MCAM, the power switch cable (shown on Figure X0) should be connected.   
 

 

Figure X0: Power supply enable key 

The power supply is located at the rear  of the MCAM and can be reached once the left side panel is 
disassembled, as shown in Figure X1.  The power switch cable can be found near the power supply. 
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Figure X1: System power supply 
 
Figure X2 shows the port on the power supply into which the power switch cable must be connected.  
The cable should click into place with the locking clasp engaged.  
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Figure X2: Power switch cable properly connected to the power supply 
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MCAMTM Accessories 

Monitors 
 
Recommended monitor options for the MCAM™: 

●​ Dell 27 Monitor - P2722H - Full HD 1080p, IPS Technology, 8 ms Response Time 
Can be purchased from Amazon: 
https://www.amazon.com/Dell-27-Monitor-Technology-Response/dp/B096W49KBL 
 

●​ Dell 24 Monitor - P2422H - Full HD 1080p, IPS Technology, ComfortView Plus Technology 
Can be purchased from Amazon: 
https://www.amazon.com/Dell-24-Monitor-Technology-Comfortview/dp/B096T36G8L 

 

1.​Graphical User Interface (GUI) 

1.1 Opening and Closing the MCAM™ 
After installing the acquisition software, and turning on the MCAM™, the Graphical User Interface (GUI) 
can be started by clicking on the Ramona Optics application launcher on the sidebar. The MCAM 
viewer will automatically start when the GUI opens. If the GUI has already been opened and the MCAM 
viewer has been turned off, it can be started using the “Open MCAM” button in the middle of the 
display (Figure 2). By default,  the MCAM™ will attempt to connect to each of two components:  

●​ The transmission illumination board 
●​ The stage motor 

If any of these components are unavailable, the user can choose to disconnect them by opening the 
“Advanced” menu on the toolbar, clicking “Advanced Settings”, navigating to the “subcomponents” 
tab, and deselecting the subcomponents . This will automatically disable the ability to change the 
settings for these components. 
 
The MCAM™ can be closed using the “Exit” button from the File menu,  or by exiting the GUI 
with the red “X” button in the upper right corner. Either method will stop all ongoing operations 
and safely close the MCAM™. 
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Figure 2: GUI start screen, with the “File” menu open and highlighted. 

1.2 GUI Navigation 
The user can zoom and pan in the GUI to view any section of the streamed or acquired images. To 
zoom, either scroll up and down on the mouse wheel, or move the mouse while holding the right click 
mouse button. To pan, move the mouse in any direction while holding down the left click button. 
 
At the top left of the window (Figure 3, #1) the current workspace is displayed. This is the location 
where all files will be saved. If a workspace has not yet been selected a message will be displayed 
suggesting to select a workspace. 
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Figure 3: Falcon GUI layout with 1) Selected Workspace, 2) Image Acquisition Mode Buttons, 3) Image Acquisition Settings Panel, 4) 

Picture-in-picture and 5) Key Image Specifications highlighted. 
 
At the top of the GUI the Image Acquisition Mode toolbar allows the user to control all 24 cameras at 
once using the “Stream All Sensors” button or in subsets with the “Stream Subset” function (Figure 3, 
#2). The user can also freeze the image in order to pause the sensor streaming at key points in time to 
allow for further examination of the frame.  
 
The image acquisition settings panel is on the left side of the viewing window (Figure 3, #3). This panel 
is used for adjusting the sensor and LED settings, fluorescence control, and stage positioning. 
Additional details for each subsection is described in section 2.  
 
While panning, the picture-in-picture (Figure 3, #4) in the right-hand corner of the screen shows what 
portion of the full image is currently displayed.  
 

 
Figure 4: Key Image Specifications 

  
Some key image parameters are displayed at the bottom of the viewing window (Figure 3, #5 and 
Figure 4) including a scale bar providing an approximate scale. Note that the scale bar assumes a 
constant width for each pixel, and may not be accurate across the entire sample if 3D features are 
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present. Additionally on the right side, RGB color values of the LEDs are displayed which have been 
preselected using calibration data. 

2. MCAM™ Image Acquisition Settings 

2.1 Settings Panel 
Most of the MCAM™ image acquisition settings can be adjusted using the Settings Panel on the left side 
of the GUI (Figure 3, #3). The panel can be hidden to make more room on the screen by clicking on the 
white line border between the settings panel and the image, and sliding to the left. The GUI allows the 
user to set the system parameters within a range of values acceptable for most common experimental 
setups. More customized settings can be set in the Advanced submenu. 

Most settings values can be adjusted either by using the sliders or by directly typing a value 
into the text box. When using the text box, the accepted values will still be limited to the maximum and 
minimum values shown on the respective slider. In addition, the setting displayed in the text box may 
adjust to a value slightly higher or lower than the value entered. This is because for  certain  settings  
(particularly  digital  and  analog  gain),  the  MCAM™  can  only  accept  distinct values. The GUI will 
automatically round the entered setting to the nearest acceptable value, and send that parameter to 
the MCAM™ system. 

2.2 Loading/Saving Settings  
On first use, the GUI will load a set of predetermined default settings which were chosen to produce 
generally high quality images. Afterwards, the GUI will automatically load the settings from its last use. 
Because each unique imaging environment and sample may have different optimized settings, the 
settings for individual experiments can be saved and loaded using the “File” menu in the toolbar. The 
default settings can also be re-loaded using the “Restore Default Settings” button in the same menu. 

2.3 Image Acquisition Settings 
The sensor exposure, gain, and LED parameters can all be set from the setting panel on the left side of 
the GUI, as well as contrast levels of the displayed image. These settings are further explained below. 
 

 
Ramona Optics - MCAMTM User Guide for Automated Workflows 

​ ​ ​ ​ ​ ​ ​ ​ ​ ​ ​ ​  
​ 20 



2.3.1 Exposure:  
This setting controls the amount of time that the camera sensor acquires light for each frame. A longer 
exposure will yield a brighter image with more motion artifacts while shortening the exposure will 
darken the image with fewer motion artifacts. Additionally this setting will affect the framerate when 
using streaming acquisition modes with longer exposures decreasing potential framerate. In order to 
maximize framerate, consider keeping the exposure as low as possible and balance lighting with the 
brightness setting. 

 
 

 
Figure 5: Camera sensor settings. 

2.3.2 Digital and Analog Gain:  
Gain settings will magnify the signal produced by the image sensors. Analog gain increases the 
sensitivity of the sensors using hardware while digital gain increases the signal using software to 
multiply the signal once it has been converted to a digital signal. Increasing gain values will increase 
image intensity but will also increase noise proportionally. Keeping gain values as low as possible will 
reduce inherent signal noise. 
 

2.3.3 Brightness:  
Located under “LED Settings”, this will control the overall brightness of the LEDs used to illuminate the 
sample. 
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Figure 6: GUI LED board settings 

2.3.4 LED Board Selection:  
The transmission LED board is the standard light source for use with the MCAM™ Kestrel when imaging 
semi-transparent samples and is installed at the top of the unit. Selecting this light source, the stage 
will be lit from above and pass through the sample before reaching the camera sensors. The reflection 
LED board is not available in this version of the MCAM..  

2.3.5 LED Board Mode:  
Currently, the LED board can be set to one of two modes, shown in Figure 6. “Full Array” will light up 
every LED on the board, while “Outer Perimeter” will light up a single row of LEDs on the outside of the 
chosen board. These settings apply to the LED board. 
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2.3.6 Z-Stage Height Settings:  
The location of the Z-stage can be changed using either the up and down arrows or by manually 
entering a location (given in millimeters from the highest point where the stage can be positioned) as 
shown in Figure 7. Step size controls the increment by which the arrows will adjust the height. 
Adjusting the Z-stage location will move the stage and sample in and out of focus. 
 

 
Figure 7: Z-stage settings. 

2.3.7 Mechanical State: 
To eject and retract the plate stage, select the mechanical state option in the left side bar. A dropdown 
menu will appear with the option to select “Acquisition” “Sample Loading'' and “Sample Unloading” 
(Figure 8).  “Sample Loading” and “Sample Unloading” will cause the stage to eject from the MCAMTM  

while “Acquisition” will retract the stage into the device.  In the case of a mechanical failure, a manual 
stage control is located in the back left of the device (Figure 1.5). 
 

Figure 8: Ejecting and retracting the plate stage 

2.3.8 Gamma:  
Adjusting this value will control the displayed image’s sensitivity to bright and dark tones and is an 
effective method of controlling the overall image contrast as perceived by humans. Reducing Gamma 
will decrease shadows and darker tones yielding a brighter image (Figure 9, 10). 
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Figure 9: GUI contrast settings. 

2.3.9 Max and Min Levels:  

The “Max level” and “Min Level” sliders are used to set the contrast of the image as displayed in the 
GUI (Figure 9). All pixels in the raw image data with values equal or greater to the selected “Max Level” 
will be displayed using the highest pixel value, while any data pixels with values below the “Min Level” 
will show up as black. The remaining middle range of pixels will be displayed using the full range of 
display pixel values. These settings are only for immediate display, and do not impact the data being 
gathered or saved. Figure 10 shows the impact on the displayed image of changing the Max and Min 
levels.  

 
Figure 10: Images with different Max and Min levels: 0 and 1 (left), 0.7 and 0.2 (center), 0.5 and 0.5 (right). 

 

 
Ramona Optics - MCAMTM User Guide for Automated Workflows 

​ ​ ​ ​ ​ ​ ​ ​ ​ ​ ​ ​  
​ 24 



3. Stream and Acquire Images 
Buttons for streaming images are located at the top left of  the GUI (Figure 11). The GUI can display 
images streamed from all 24 cameras or images streamed by a subset of selected cameras. If the user 
would like to freeze an image to capture specific instances, the “Freeze Image” is available.  

Figure 11: Buttons for streaming sensors 
 

The GUI can stream from any one of the  cameras (see Figure 11) or groups of cameras in the array, in 
full resolution mode. When streaming in single camera mode, the user can double click on any part of 
the image to stream from the respective camera capturing that area. All cameras not currently 
streaming will appear darker (Figure 12). Streaming can be stopped at any time by pressing “Freeze 
Image”, which will pause the streaming. 

  
Figure 12: Streaming from a subset of cameras 
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3.1 Save and Export Images 

3.1.1 Save Image via toolbar  
MCAM™ data can be exported or saved from the GUI in several ways. First, high resolution images can 
be exported using the “Save Image” button in the left panel (Figure  13).  First, assign the image a 
specific name in the “Image Name” section.  Next, click the “Select File Location” to assign a directory 
for the image to be saved in.  Lastly, select “Save  Image” to capture a screenshot of the section of the 
plate that is in view. This  will  save  the  full  resolution  MCAM™  data  in  a  single  “ .nc”  file  which  can 
be opened for analysis in the Ramona Optics custom MCAM™ Image Viewer or in MathWorks software. 
“Open Workspace” will open the directory in which the most recently saved images were placed. “.nc” 
files use the netcdf4 data format. More information on the implementation and usage of this file 
structure can be found here: https://unidata.github.io/netcdf4-python/. Notes can be entered in the 
“Additional Information” field which are saved as metadata in the  image file and displayed in the 
MCAM™ Viewer with the image. 

​ ​                                           Figure 13: Save settings. 
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Saved images are given a filename according to the following rules: 

1.​ The user defines the prefix of this filename by entering in the “Image Name” field 
(Figure  13).  

2.​ The suffix of this filename is generated as a timestamp with the following format​
YYYYMMDD_HHMMSS_mmm where: 

○​ YYYY is the year when the image is saved, e.g. 2020. 
○​ MM is the month when the image is saved, e.g. 08. 
○​ DD is the day when the image is saved, e.g. 06. 
○​ HH is the hour (in 24 hour format) when the image is saved, e.g. 15. 
○​ MM contains the minute when the image is saved, e.g. 43. 
○​ SS contains the seconds when the image is saved, e.g. 52. 
○​ mmm contains the milliseconds when the image is saved, e.g. 549. 
○​ The final timestamp will appear as: 20200806_154352_549 

3.1.2. Screenshot function  
Screenshots of the currently displayed images can be saved using “Capture Screenshot” in the “File” 
menu of the toolbar. This screenshot will include the main canvas, the settings toolbar,  and the 
picture-in-picture and the main settings (Figure 14). 
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Figure 14: Screenshot of GUI Images 

 
Note: If a filename is entered in the “Image name” field and the workspace is changed, the filename 
will be deleted and the user will need to enter a new filename. 

3.1.3 Acquiring individual well images  
If the user requires high resolution images of each well in individual tif files, navigate to the “Assays” 
menu and select “Acquire and Save Image Assay” (Figure 15). In the “Save Mode” dropdown, select 
“Export Images as Tif”. Next, the user will need to define the well plate configuration which is largely 
defined by the number of wells in the plate being imaged. Multiple Well Plate Configurations are 
preloaded as part of the software and include 6, 24, 48, 96, and 384 well plates. Once a well plate 
configuration file is selected, the wells in the image will be outlined in blue. Ensure the blue outlines 
are aligned correctly before acquiring the image using the “Take Image” button.  

Figure 15: Acquire and Save Image prompt 

3.1.4 Defining New Well Plate Configuration  
If a new well plate configuration needs to be defined, the user will need to create a new Well Alignment 
file by navigating to “Assays'' and selecting “Well Alignment”(Figure 16). Next, enter the number of 
columns and rows present on the current plate, then select “Detect Well Alignment” and the software 
will generate red outlines for each well across the plate. Generally, the red well outlines will not be 
aligned completely across the plate. The user will need to manually align the wells in the four corners 
of the plate by double clicking the dot in the center of the well and dragging the outline into the proper 
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orientation. Once the wells in the four corners of the plate have been aligned correctly, select “Update 
Well Alignment” to automatically align the rest of the wells. After confirming the alignment is correct, 
select “Save Well Alignment” and name the new well alignment file to correspond to the new plate 
type.  

 
Figure 16: Defining Well Alignment 

3.2 Acquire Video or Z-Stack 
To acquire a video, select “Assays” from the top toolbar menu and select “Acquire Video”. An “Acquire 
Video” prompt will appear on the right side of the screen (Figure 17). Click “Select File Location” to 
designate the location the video file will be saved. The “Additional Information” box is available for any 
notes the user would like to include about the video. The user also has the option to create a video of 
the full array to capture the entire plate or a specific subset of wells within the plate. When acquiring 
videos, the user can adjust the frames per second and acquisition duration in the “Frame Rate 
Settings” section of the Acquire Video prompt. The MCAM GUI will automatically calculate the total 
number of frames and estimate the size of the video file and available memory of the system.  
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Figure 17: Acquire Video Prompt in Assays menu 

 
To acquire a Z stack, select “Assays” from the top toolbar menu and select “Acquire Z Stack”. An 
“Acquire Z Stack” prompt will appear on the right side of the screen (Figure 18). If a Z-stack protocol 
has already been defined and saved select “Load Protocol”. To create a new protocol, select the correct 
“Well Plate Configuration” file that corresponds to the imaging plate. To set the range of the Z stack, 
adjust the start height (bottom of the stack) and the end height (top of the stack) in the “Z stage” 
section. The mid height will be automatically calculated based on the start and end height. The step 
size indicates the range between each stack that is collected. The number of steps will be 
automatically calculated based on the start height , end height, and step size supplied by the user. In 
the “Save Settings” section of the prompt, select the file location and input a folder name based on the 
naming convention suggested in 3.1. To save the Z-stack protocol for future use, click the “Save 
Protocol” button in the top right of the prompt.  
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Figure 18: Acquire Stack  Prompt in Assays menu 

3.2 MCAM compatibility with Green Button Go automated 
scheduler  
The MCAM-B is compatible with automated workcells and has been integrated into Biosero’s 
automated laboratory scheduling system, Green Button Go. An example workflow in the Green Button 
Go interface is outlined below (Figure 19). For support with Green Button Go, please contact Biosero.  
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Figure 19. Green Button Go integration with MCAM  

3.3 Existing protocols in the MCAM GUI 
Below is a summary of the potential plate types that will be used in the assays as well as their physical 
dimensions and suggested imaging parameters. An assay protocol for each plate type in Table 1 will be 
preloaded on the MCAM GUI as a starting point. To load an existing protocol select “assays” in the 
toolbar and click “Acquire Z Stack”. Open “Load Protocols” at the top of the prompt, navigate to the 
Desktop and open the folder labeled “Protocols.” In that folder, an assay for each plate type in Table 1 
will be available along with the corresponding “Well Alignment” files.  Alternatively, the user can drag 
and drop the protocol .json files into the GUI to load the desired protocol. It is suggested before 
running any of the preset acquisition protocols in the workcell to adjust the imaging settings based on 
the user’s input material (see section 2). To save any changes made to an existing protocol, simply click 
“Save Protocol” after optimizing the imaging parameters. 
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Table 1: Suggested imaging parameters based on plate type 
 

Potential Assay Plates Suggested Imaging Parameters 

Company 
Catalog 
Number Wells Shape Walls Material 

Well dimensions mm 
(height, top, bottom) 

Z-stack depth 
(mm) 

Number of 
slices 

Step size 
(mm) 

Greiner 655180 96 F Clear Polystyrene 10.9 x 6.96 x 6.58 2 5 
 

0.5 

Corning 7007 96 U Clear Polystyrene 11.3 x 6.86 x 1.80 3 7 .5 

Greiner 651161 96 V Clear Polystyrene 10.03 x 6.18 x 1.80 3 7 .5 

Greiner 655090 96 F Black Polystyrene 10.9 x 6.96 x 6.58               2 5 
 

0.5 

Corning 4520 96 U Black Polystyrene 12.54 x 6.86 x 1.85 2 5 
 

0.5 

Corning 4516 384 U Black Polystyrene 12.54 x 3.63 x 1.80 2 5 0.5 

Perkin 
Elmer 6057300 384 F Black Cyclic Olefin 12.7 x 3.26 x 3.26 1.5 4 0.5 

Greiner 657160 6 F Clear Polystyrene 16.5 x 35.58 x 35.58 3 
7 
 0.5 

Greiner 662160 24 F Clear Polystyrene 16.5 x 16.28 x 15.7 2 5 0.5 

Greiner 677180 48 F Clear Polystyrene 16.5 x 11.95 x 11.37 1 20 0.05 

Note - Bottom dimension of flat well plates is the width of the flat surface. Bottom dimension of U and V bottom plate 
is the depth of curvature 

3.3 Quick Guide to creating a new protocol 
If a new plate type is being integrated into the workcell, the user will need to create a new protocol. It 
is recommended to have organoids plated in the new plate type during new protocol optimization to 
capture the imaging parameters appropriately.  To create a new protocol follow the instructions below. 

1.​ Open the MCAM™ GUI as described in section 1.  
2.​ Load the new plate type containing organoids by navigating to the Mechanical State 

dropdown and select “load acquisition” to eject the stage. 
3.​ Once the plate is positioned securely in the stage, select “Acquisition” in the 

Mechanical State dropdown.  
4.​ Using the wells containing organoids, adjust the Sensor Settings, LED settings, and any 

additional Image Adjustments according to section 2 of the manual.  
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5.​ If a “Well Alignment” file hasn’t been created for this particular plate type, select 
“Assays” and “Well Alignment”.  

a.​ Input the correct number of columns and rows in the “Well Format” section.  
b.​ Select “Detect Well Alignment” to generate red outlines for each well across 

the plate.  
c.​ If the red outlines are not aligned correctly, click and drag the outlines into the 

proper alignment for the 4 corner wells of the plate and select “Update Well 
Alignment” when complete. (see 3.1.4 for how to) 

d.​ If all the red outlines are correctly aligned, “Save Well Alignment” and continue 
to step 6.  

6.​ Navigate to the “Acquire Z stack” prompt  under the “Assays”menu in the toolbar. In 
the “Z Stage” section, determine  the start and end height of the stack as outlined in 
section 3.2. Determine the desired step size based on experimental design. 

a.​ Note: Increasing the number of stacks in the acquisition will impact the speed 
of acquisition. This will need to be optimized based on the desired speed of 
acquisition.  

7.​ In the “Options” section the user can select either .nc (MCAM Viewer only) or .Tif files as 
well as setting timing delays if necessary.  

8.​ In the “Savings Settings” select a file location and folder name for the Z Stack images 
to save in.  

9.​ To save the protocol for future use click “Save Protocol” in the top right of the prompt.  
10.​ The user can now proceed with imaging by selecting “Acquire Z Stack” at the bottom. 

 

4. Image Acquisition Optimization 

4.1 Calibration Graphs  
The GUI contains interactive graphs to assist with calibrating the system. These can be opened by 
selecting “Calibration Graphs” under “View” in the toolbar. Both graphs will display data for whichever 
cameras were most recently being streamed or acquired from.  If the full camera array field of view was 
recently acquired, the graphs will display data for the array. If the subset function was being used, the 
graphs would only reflect the data from the cameras selected in the subset. 

If the graphs are open, they will by default update for each new frame. If this causes the GUI to 
slow down to an unacceptable level, this can be disabled by deselecting “Update graphs on every 
frame” under “Advanced”→“Graphing” in the toolbar. If automatic update is deselected, the color 
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histogram can be updated by acquiring a new full resolution image or by clicking “Update Histogram”, 
and the focus graph will be updated whenever the stage height changes or a new camera(s) is 
streamed from. 
 

 
Figure 20: GUI with color histogram and focus graph open.  

4.2 Color Histogram  
The color histogram displays what percentage of the pixels take on a given value between 0 and 255. 
This can help the user find the ideal LED and exposure/gain settings to achieve the desired white 
balance in the acquired images. By default,  the histogram displays on a linear scale,  but this can be 
switched to logarithmic by right clicking on any of the plotted lines and selecting “Plot Options” -> 
“Transform” and selecting “Log X” or “Log Y”.  The histogram will always display the color values for 
the raw data, and will not be affected by changing the displayed contrast with the Max and Min Level 
sliders. 

4.3 Focus Graph 
The focus graph (Figure 20, bottom right) displays the calculated focus score for a given camera(s) at 
different stage heights. The graph is intended to help the user find the stage height which best focuses  
the  current  sample. The  graph  will  update  as  the  arrow  buttons  are  used  to  move  the MCAM™  
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stage  up  and  down. The highest point of the resulting curve is the most focused. Because each 
camera or set of cameras will have a slightly different focus graph curve, the graph resets each time 
the streaming mode or camera being streamed from is changed. The  focus  score  is  purely  
qualitative,  and  should  only  be  used  to  compare  images  of  the  same sample taken under 
identical lighting and imaging conditions. Altering  the  exposure,  gain,  or  other  system  parameters  
will likely change the focus score and make the graph difficult to interpret. If the system parameters or 
environment changes, the user should press the “Reset focus graph” button to ensure the data is 
accurate. 

4.4 Advanced Settings  
Additional settings can be found in the “Advanced” menu and are described below (Figure 21). 

 

 
Figure 21: Advanced Menu 

4.4.1 Image Stitching 
The individual images can be displayed in the GUI as stitched or unstitched. The full image is stitched 
using a calibration file specific to the individual MCAM™ setup (see System Calibration), which the GUI 
automatically loads and uses to place the images in the GUI canvas. If the image is un-stitched, the 
central square from each imaging sensor will be displayed with a small border between them (Figure 
22). Whether the image is stitched or unstitched makes no impact on the GUI performance.  
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Figure 22: GUI with unstitched image 

4.4.2 Select Components 
By checking or unchecking respective boxes, the user can activate or deactivate components 
connected to the MCAM™. 

4.4.3 Sensor Corrections 
Checking this box applies sensor corrections calculated during system calibration. The default state for 
this setting is active. 

4.4.4 Additional Settings 
The additional settings window allows the user to set the minimum and maximum values that the GUI 
will accept for the exposure and gain settings (Figure 23).  
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Figure 23: Additional Settings Window. 

5. Viewing Data Acquired by the MCAM 
The images acquired by the MCAM can be viewed in a variety of ways: 

1.​ Per-micro camera images: Data can be exported on a per-micro camera level allowing them 
to be viewed and analyzed in isolation. A metadata file includes information about the MCAM 
system that was used to acquire the images in a machine readable format. 

2.​ Stitched image of the entire FOV: Data can be exported using the GUI into a single stitched 
image. This is most appropriate for publication quality images. Unfortunately, many image 
viewers struggle to load images more than 100 Megapixels in size, limiting the use of this 
image format. 
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NC of the original data: The standard NC files that are used throughout the MCAM software retain the 
original data. This data can be loaded into other applications such as Python and Matlab, but requires 
users to apply many of the corrections we apply in the MCAM Viewer application. For more information 
about the dataset, please refer to our documentation found online: 

https://docs.ramonaoptics.com/python_metadata.html  

5.1 MCAM™ Viewer 
The MCAM™ Viewer software allows for viewing images that have been previously acquired and saved 
using the MCAM™ GUI.  
 
The MCAM™ viewer software is provided as a distributable executable (see MCAM™ Viewer Installation, 
section 5.2) and can be run using Windows 10 or Linux systems. Compatible file types include “.nc” 
files which use the netcdf4 data format as well as “.jpg” images. Note: “.jpg” images generated by 
exporting screenshots from the GUI may also have an associated “.json” file containing relevant 
metadata which can also open in the viewer.  
 
In the MCAM Viewer, image contrast can be adjusted using the Gamma, Minimum Level and Maximum 
Level settings in the bottom left corner. Metadata that has been saved with image files is displayed on 
the left side of the viewer window. Additionally, functionality similar to the MCAM™ GUI is available 
including the focus graph, color histogram, sensor corrections, stitching, and raw versus rgb display 
(see section 4 more information). 

5.2 MCAM™ Viewer Installer  

5.2.1 Windows:  
https://drive.google.com/file/d/1S8Mlv0NT-9vwTrm7t2wXOEFrh8jllfWw/view 
Before starting with the installation of the software, it is recommended to ensure that any old versions 
of the software are uninstalled. You may uninstall old versions by Opening the Windows start menu, 
and searching for “Apps & Features” then selecting “Uninstall MCAM Viewer”. 

5.2.2 Linux:  
https://drive.google.com/file/d/14vqRB6t8UYrO8KlxkQ8juXyVRVMB3Q8-/view 
All required software has been installed on the MCAM workstation prior to delivery. 
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5.2.3 Software Updates:  
Contact us at help@ramonaoptics.com if you think your software may be out of date. 

 
Figure 24: MCAM™ Viewer Window. 

5.3 Video Playback 
The MCAM™  Viewer allows for video playback with multiple settings affecting playback speed.  
Frame Skip allows the user to specify an interval of frames per the player will skip between frames. 
Viewer FPS allows the user to request a playback FPS. This is dependent on the amount of data in each 
frame. 
Combining these options allows for a user to reach a higher effective FPS than otherwise possible. 
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5.4 Stitching Images Through MCAM™ Viewer 
These instruction can be supplemented with these slides 

1)​ With your desired single frame dataset loaded into the MCAM™ Viewer navigate to File>Export 
Image (as stitched). 

2)​ The stitching window will pop up with your image in the viewer. 
3)​ Select the output resolution of your stitched image. The default “Native Resolution” will create 

a stitched image at the resolution of the raw data included in the field of view (FOV). The 
maximum size is listed in parentheses. 

4)​ Once resolution is selected, frame the viewer to the FOV you would like your stitched image to 
cover. You can navigate this viewer the same as in the MCAM™ Viewer and MCAM™ Falcon. 

5)​ To quickly fit the FOV to the full composite press the “Reset View” button. 
6)​ Once the preview window is set, press the “Stitch” button. This will bring up a File Navigator 

that will allow you to select the filename of the stitched image. 
7)​ Stitching process can be monitored in the textbox at the bottom of the stitching window. 

 

6. Introduction to the MCAM Web API  
 
The MCAM provides a web API for seamless integration into automated workflows. At its core, 
the MCAM web API tries to approach a REST API while enabling control over the MCAM’s 
mechanical capabilities. 
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6.1 System Architecture 
The MCAM server computer, that runs the web service for the MCAM acquisition control and 
image analysis, listens on port 8800 for incoming requests. The system is assumed to be 
connected to the local network via ethernet. The MCAM and the MCAM server are assumed to 
always be connected to one other. The controlling scheduling system (e.g. Green Button Go) is 
assumed to be installed on a different computer, and able to communicate with the MCAM 
server on the same secure network. 

Network Connection 
The MCAM is assumed to be connected to the local network via ethernet. At minimum, a 1 
Gbps network connection is required, and a 2.5 Gbps connection is recommended. Depending 
on the demands of the application, a 10 Gbps can be accommodated on the MCAM server. 

Security Model 
The MCAM assumes that it is placed in a secured facility. The server is configured to listen to 
any requests that arrive at its IP address. The server can be configured to require certain 
credentials described below, but these are only advised to prevent accidental requests, and not 
malicious requests to the MCAM server. 

HTTP Basic Authentication 
To enable HTTP Basic Authentication, the server must be started with the environment variable 
RAMONAOPTICS_WEBMCAM_AUTHENTICATION set to “httpbasic”. The username and 
password can be set from the RAMONAOPTICS_WEBMCAM_USERNAME 
RAMONAOPTICS_WEBMCAM_PASSWORD environment variables. 

Shared File Server Installation 
Upon installation, the Ramona Optics will work with the client to mount the shared file server so 
that it appears as a local folder on the MCAM server. We briefly describe a few known share file 
configurations that are compatible with Ramona Optics’ MCAM server. 

6.2 API Function Calls 
There are 8 basic API endpoints: 
 

1.​GET /v1/status 
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a.​ The response contains an entry with information pertaining to the MCAM server 
application. The main information returned in this endpoint is the version of the 
server application described in owl_version 

i.​ owl_version: The version of the MCAM server application. 
2.​GET /v1/mcam/search 

a.​This call is generally issued once upon instrument startup. 
b.​ It returns a list of available serial numbers that may be available to clients to 

open. 
3.​GET /v1/mcam/{serial_number} 

a.​Return status information fo the MCAM serial number specified in the request 
4.​POST /v1/mcam/{serial_number} 

a.​The MCAM server application claims control over the MCAM instrument.  
b.​The MCAM will automatically enter a retracted state when it is open. 
c.​ This endpoint can take 10-30 seconds to startup and ensures that the motion 

subsystem of the MCAM is ready to take commands. 
d.​ This command may fail for the following reasons: 

i.​ The MCAM is powered off while the MCAM server is powered on 
ii.​ Another application is connected to the MCAM (e.g. the native 

application). 
5.​DELETE /v1/mcam/{serial_number} 

a.​The MCAM may enter a retracted state when the communication connection is 
closed. 

b.​ This call is generally called if the user wishes to use the MCAM instrument with 
the native graphical application for troubleshooting. 

6.​GET /v1/mcam/{serial_number}/state/search 
a.​ Provides the list of available states for a particular MCAM. 

7.​GET /v1/mcam/{serial_number}/state 
8.​POST /v1/mcam/{serial_number}/state 

a.​ Requests that the MCAM enters a particular state. 
b.​ "acquisition" state: 

i.​ In this state the sample holder (if present) is retracted and the MCAM is 
ready to acquire images. 

ii.​ The MCAM will automatically enter this state when the /run_assay 
endpoint is called. 

c.​ "loading" state: 
i.​ The sample holder is extended into the defined loading position. 

d.​ "unloading" state: 
i.​ The sample holder is extended into the defined unloading position. 

9.​GET /v1/mcam/{serial_number}/assay/search 
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a.​ Returns a list of strings, each an identifier of the different types of the available 
assays (or experiments) that can be run on the MCAM.  

10.​ GET /v1/mcam/{serial_number}/assay/{assay_name}/configuration 
a.​ Return a list of strings, each containing a valid configuration of the different 

available assay configurations. 
11.​ GET /v1/mcam/{serial_number}/assay/{assay_name} 

a.​ Returns the assay schema. 
12.​ POST /v1/mcam/{serial_number}/assay/{assay_name} 

a.​ This is the main function to call to acquire and process data. It is described in 
detail in subsequent sections. 

 

6.3 API Function Workflow 
The API is documented in detail in the staging website. The openapi.json can be downloaded 
from the staging website. Most requests are HTTP Post requests and take in their parameters 
through a json request body. 
 
The general workflow can be summarized by: 
 

1.​ Only a single client application is assumed to be communicating with the MCAM at once. 
a.​ Initially, no locking mechanism exists to avoid conflicts between multiple clients. 

2.​ The client application (installed a different computer) checks the GET 
/v1/mcam/search endpoint. 

a.​ If the returned value of serial_numbers is an empty list, then the webserver is not 
connected to the MCAM instrument (this can occur if a user was trying to access 
the MCAM with the native application). 

b.​ If the returned value of the serial_numbers contains one or more strings, it 
indicates the serial number of the MCAM connected by the server. 

3.​ The client application initiates a connection with the MCAM of its choice through the 
POST /v1/mcam/{serial_number} endpoint 

4.​ The client application then probes: 
a.​GET /v1/mcam/{serial_number}/state/search 

i.​ To get a list of the available mechanical states of the particular MCAM. 
b.​GET /v1/mcam/{serial_number}/assay/search 

i.​ To get a list of the available assays for the MCAM 
5.​ The client application sets the state of the MCAM to load the sample by issuing a post 

request to POST /v1/mcam/{serial_number}/state with the desired state. 
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6.​ The client application issues a call to the POST 
/v1/mcam/{serial_number}/assay/{assay_name} endpoint as described 
below 

a.​ After the call to run_assay, the MCAM may be in an arbitrary state. Typically, it 
will be left in the “acquisition” state, though this can change between assays and 
the particular assay configuration. 

7.​ The client application sets the state of the MCAM to unload the sample by issuing a call 
to the POST /v1/mcam/{serial_number}/state with the particular state of 
interest. 

8.​ Repeat steps 5-7 as desired. 
9.​ Once the connection is no longer needed, one can call the endpoint DELETE 

/v1/mcam/{serial_number} to release the resources associated with the MCAM 
from the server. 

The assay endpoint 
We focus our attention on the POST 
/v1/mcam/{serial_number}/assay/{assay_name} 
 endpoint. 
 
The endpoint call specifies both the MCAM serial number that will complete the operation, and 
the assay name that will be executed. The body of the request contains 4 keys: 

●​ save_location: a string containing the location of the output files.  
○​ Required 
○​ This path is relative to the mcam server itself 

●​ metadata: a dictionary containing metadata to be added to the acquired dataset. 
○​ Optional 
○​ This dictionary can contain multiple key value pairs. All keys must be strings. The 

values may be strings, floating point numbers, or integers. 
●​ configuration: A string containing preconfigured settings for the particular assay.  

○​ Optional 
○​ If not provided the default parameters for the given assay will be used. 

■​ The default parameters are almost surely not the ones you want to use. 
●​ parameters: A dictionary containing key value pairs to overwrite in the assay parameters 

specified in the assay_filename.  
○​ The default key value pairs are those provided by the settings file defined in 

assay_filename. 
 
For example, they may be specified as json application data. As a cURL request, these are 
written as  
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curl -X 'POST' \ 
  
'http://mcam_ip_address.local:8800/v1/mcam/0x4EADBEEFCAFE1010BA5EDA11
/assay/acquire_and_save \ 
  -H 'accept: application/json' \ 
  -H 'Content-Type: application/json' \ 
  -d '{ 
  "save_location": "/shared_folder/data/my_file_location", 
  "metadata": { 
​ "barcode": "A329812", 
​ "operator_name": "John Doe" 
  }, 
  "parameters": {} 
}' 

6.4 Environment Variables used by the MCAM Server 
The MCAM server can be configured via the following environment variables to adjust the 
server settings: 
 

Environment 
Variable 

Usage Allowed values Example 

RAMONAOPTICS_WEBMCAM_
AUTHENTICATION Specifying the authentication 

method. 
httpbasic or empty (no 
authentication required) 

httpbasic 

RAMONAOPTICS_WEBMCAM_
USERNAME Username when httpbasic 

authentication is used. 
Any string, spaces are 
discouraged. 

ramona 

RAMONAOPTICS_WEBMCAM_
PASSWORD Password when httpbasic 

authentication is used. 
Any string, spaces are 
discouraged. 

gigapixel 

RAMONAOPTICS_WEBMCAM_
EXTRA_AVAILABLE_SERIAL_N
UMBERS 

Specifying additional serial 
numbers that “appear available” 
when testing the MCAM. 

A list of comma separated 
strings. 

RAMONAOPTICS_WEBMCAM_EXTRA_AVAILABLE_
SERIAL_NUMBERS=0x4EADBEEFCAFE1010BA5E
DA11  

RAMONAOPTICS_WEBMCAM_
STARTUP_SERIAL_NUMBER Serial number to which the 

WebMCAM Server connects to 
upon startup. 

A single serial number (string) RAMONAOPTICS_WEBMCAM_STARTUP_SERIAL_N
UMBER=0x4EADBEEFCAFE1010BA5EDA11 

RAMONAOPTICS_WEBMCAM_
PORT Network port on which the 

server lists. 
A number specifying the port on 
which the server listens  

RAMONAOPTICS_WEBMCAM_PORT=8800 

RAMONAOPTICS_WEBMCAM_
SSL_KEYFILE SSL keyfile used for https 

communication. 
A valid local path. RAMONAOPTICS_WEBMCAM_SSL_KEYFILE=/hom

e/ramona/cert/webmcamdemo.ramonalabs.
com+3-key.pem 

RAMONAOPTICS_WEBMCAM_
SSL_CERTFILE SSL certfile used for https 

communication. 
A valid local path. RAMONAOPTICS_WEBMCAM_SSL_CERTFILE=/ho

me/ramona/cert/webmcamdemo.ramonalabs
.com+3.pem 
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7. MCAM Server Setup 

7.1 Remote Access Via SSH 
Ensure that the MCAM and MCAM server are powered on, and connected to the network. 

a.​ The MCAM computer hosts an SSH server. 
b.​ If no SSH key is setup on the machine, a local login can be used to install the  

cat id_rsa.pub >> ~./ssh/authorized_keys 
 
If working behind a router or firewall, you will have to set up the correct firewall rules and port 
forwarding rules to the connection through. 

7.2 Troubleshooting Firewall Issues 
The MCAM computer will attempt to launch the web server in a tmux session on bootup. 
However, access from another computer may be blocked due to network security. To verify that 
the MCAM server is correctly started, use a terminal on the MCAM server to connect to the tmux 
session. You can connect to the tmux session through the command: 

 
tmux a 

 
and you will have access to the running web server. 
 

 
 
From the MCAM computer, you can check that the server is running by connecting to the 
website through the installed web browser (Firefox or Google Chrome): 
 

https://localhost:8800/docs 
 
Verify that the screen looks similar to the above image of the correctly running web server. 
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Verify you can connect to the documentation page in a web browser by navigating to the ip 
address and the port shown in the tmux session.  
 
Once you have verified that the server is correctly configured on the MCAM computer, you 
should disconnect from the tmux session: 
 
​ Ctrl+b, then d 
 
To list the IP addresses of the MCAM computer, you can use the command 
 
​ ip a 
 
The IP addresses will be listed next to network each interface. The IP address will often start 
with 10.X.X.X where each X represents a number between 0 and 255 (inclusively). Once the IP 
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address of the MCAM server has been identified, you can attempt to connect to the MCAM 
server on your workstation through the address: 
 
​ https://10.X.X.X:8800/docs 
 
If you are unable to connect to the WebMCAM webpage, a temporary solution to get around a 
problematic firewall is to use a WiFi hotspot on the MCAM computer and connect to it directly. 
This should allow direct communication without any firewall interference. If you are resorting to 
this solution, you should contact your network administrator to ensure that a long term solution 
can be found to connect to the MCAM server through a wired ethernet connection. 

7.3 Windows SAMBA Setup 
If a Windows SAMBA is required Ramona Optics will install the required cifs utilities on the 
MCAM server. Users may work with the Ramona Optics engineering team to ensure that the 
shared drive configuration is correctly added so that the shared drives are permanently 
mounted. 
 
If a Windows SAMBA is required Ramona Optics will install the required cifs utilities on the 
MCAM server. Users may work with the Ramona Optics engineering team to ensure that the 
shared drive configuration is correctly added so that the shared drives are permanently 
mounted. A sample configuration may resemble: 
 

sudo apt install cifs-utils 
# Create the credentials file 
echo username=myusername  > /home/ramona/.smbcredentials 
echo password=mypassword >> /home/ramona/.smbcredentials 
# echo domain=domain     >> /home/ramona/.smbcredentials 
# Add the line to /etc/fstab 
//localhost/sambashare  /shared  cifs  
credentials=/home/ramona/.smbcredentials,file_mode=0755,dir_mode=0755,user=ramona,group=ramona,nobootwait 
0       0 
sudo mount -a 
# Ensure that the drive is visible 
sudo reboot 
# Ensure that the drive is still visible 
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7.4 Staging Website 
https://webmcamdemo.ramonalabs.com:8800/docs/ 

Gaining access to the virtual MCAM shell 
If you need to gain access to a virtual MCAM bash shell, please contact Ramona Optics by 
email and provide them your public key for SSH at help@ramonaoptics.com . We will provide 
you information about the login IP and the port. 

7.5 Customization of Assays 
The MCAM API allows for a large amount of customization based on the required experiments. 
All experimental parameters are exposed to the end user based on key-value pairs stored in a 
json dictionary. Many of the parameters are described in the endpoint GET 
/v1/mcam/{serial_number}/assay/{assay_name} . Please contact Ramona Optics for 
more information about assay parameters. 

7.6 Known Limitations 
1.​ Long running assay may cause hangups with blocking http requests. 

a.​ Currently assays are expected to run between 1-second and 60-seconds. 
b.​ However, longer assays may run up to 300-600 seconds (5 minutes) which may 

cause TCP requests to drop. 
2.​ Multiple client requests can conflict. 

a.​ Currently there is no locking mechanism stopping multiple clients from issuing 
calls. 

b.​ All API calls are handled sequentially meaning that once an assay is started, it 
cannot be polled. 

3.​ Assay parameters cannot be easily validated. 
●​ An endpoint that can validate the choice of parameters for a given assay without 

executing it. 
●​ In future versions of the MCAM server, we plan to create validation endpoints that 

simply validate, without executing the assay. 
4.​ The software of the MCAM Server cannot be updated through a web API call. 
5.​ Mounting network attached storage cannot be accomplished through a web API call. 
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